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From The Chief Editor's Desk ...
As hard as it is to believe, summer in the Northern
Hemisphere is giving way to fall. The hours of
daylight are becoming increasingly and noticeably
shorter. Temperatures, especially at night and during
the early morning hours, are becoming brisk and
cooler. Leaves on the trees are starting to turn colors
and fall. Before long, it’ll be time for cool weather
jackets that will eventually yield to warmer winter
jackets, in most Northern Hemisphere locales.
Sadly, Rudge’s trusted four legged companion,
Molly, departed her human family recently. I know
we’ve all had pets that are special to us, but Molly’s
exploits were retold over and over again in the
PCLinuxOS forum by Rudge. Molly was, in a way, a

special member of the PCLinuxOS family. Molly’s
photograph even graced the cover of this magazine
in July 2013. Our pets are a very important part of
our human families, and when one of them takes
their leave from us, it leaves a deep and sad hole in
our lives. Our thoughts and hearts go out to Rudge
and JRex as they work through their loss of Molly.
Meanwhile, just as we (me and Meemaw) started to
do the PDF layout for the October issue of the
magazine, Meemaw’s laptop developed problems
(the AC/charging port was loose and would no
longer keep her laptop powered up or her battery
charged). She ended up buying a new laptop,
replacing her seven year old one. Now, she’s trying

to wrap her head around GPT, UEFI, EFI and all the
other “new” things that have come along in the past
seven years, just so she can get PCLinuxOS
installed on her new laptop. Just as I’m writing this,
she was able to finally get PCLinuxOS installed on
her new laptop, with some help and reassurance
from a PCLinuxOS forum member who wishes to
remain anonymous. I’ll let her tell you all about her
new laptop (along with her adventures in getting
PCLinuxOS installed) in a future article.
It’s easy to become somewhat complacent about our
trusted equipment. Under Linux, especially
PCLinuxOS, it just keeps working and working
without any issues. Things just run and run, without
any noticeable slowdown. There are no everexpanding anti-virus definitions to show things down.
Of course, there’s little to no worry about viruses,
either. In fact, things run so well that we rarely think
about the “newer” technologies that we might be
missing out on. Instead, we trudge along with our
trusted computers that continue to perform, day in
and day out.
But then, that trusted computer dies … or becomes
seriously “ill.” At that point, we usually have a
decision to make – fix our trusted computer, or look
among a now-foreign sea of new equipment with
new features that weren’t available when we
purchased our last computer. It can be
overwhelming, to say the least – and Meemaw had
to confront it head on.
Until next month, I bid you peace, happiness,
serenity and prosperity.

Ryan, Paul and Lexi riding the carousel at the Kansas City Zoo

PCLinuxOS Magazine

Page 3

Happy 14th, PCLinuxOS!
by Meemaw
Amazingly enough, it’s already another birthday!
PCLinuxOS was created in October 2003, so
everyone’s favorite distro is 14 years old this month!

From the PCLinuxOS Homepage

If you’re new to PCLinuxOS, you might be
wondering about the origins of PCLinuxOS. If you’re
a PCLinuxOS veteran, few tire of hearing this story
again.
It began on October 24, 2003. PCLinuxOS Preview
.4 was released as a fork of Linux Mandrake
(Mandriva) 9.2. Since that time, PCLinuxOS has
matured into its own independent Linux distribution.
Just uttering the all-still-too-common line that
PCLinuxOS is still a fork of Mandriva may cause
sparks to fly. While PCLinuxOS may have been
originally forked from Mandriva, it also borrows from
openSUSE, Fedora, Ubuntu, Knoppix, Mepis,
Debian, Slackware, Arch and just about any/every
other Linux distro around.
Our favorite packager, Texstar, says it best. In
Texstar’s words:
In the summer of 2003, I became interested in Live CD
technology after looking at Knoppix and a fresh
distribution from a fellow named Warren, called Mepis. I
was interested in helping Warren with Mepis at the time,
but I had no clue how to build DEB files. Coming from 5
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years of packaging RPMS and not really wanting to learn
a new packaging system, I happened to come across a
South African fellow by the name of Jaco Greef. He was
developing a script called mklivecd and porting it to
Mandrake Linux. I, along with Buchanan Milne
(Mandrake contributor) and a few others, began working
with Jaco to help debug the scripts. I got an idea to make
a livecd based on Mandrake Linux 9.2, along with all my
customizations, just for fun. I had previously provided an
unofficial 3rd party repository for the users of Mandrake
for many years, but had since parted ways. Since
Mandrake was a trademarked name, myself and others
decided to name the Live CD after our news site and
forum, pclinuxonline, thus PCLinuxOS.

the following 6 months rebuilding, debugging,
customizing, patching and updating our new code base.
We pulled in stuff from our old code base, utilized
patches/code from Fedora, Gentoo and Debian just to
name a few. This is why you will never see me distro
bashing, as it would be hypocritical to do such a thing.
We are still dependent in many areas on other distros
development processes due to our limited but hard
working volunteer development team.

Preview .3 was my first attempt to make a livecd. I
distributed it initially to about 20 people to get their
reaction and feedback. Everyone who tested it loved the
livecd but there was one thing missing. There wasn't a
way to install the thing to the hard drive! srlinuxx from
tuxmachines.org came up with a novel way to copy the
livecd to the hard drive and posted it on our forums. Jaco
utilized this information and inspiration from the Mepis
installer and wrote a pyqt script to make the Live CD
installable, thus the birth of a new distribution.
On October 24, 2003, PCLinuxOS Preview .4 was
released as a fork of Linux Mandrake (Mandriva) 9.2
utilizing mklivecd scripts from Jaco Greef, a multimedia
kernel from Thomas Buckland (2.4.22-tmb) and a
customized KDE (3.1.4-tex). Preview .5 through .93 were
built upon on previous PCLinuxOS releases. After three
years of updating one release from the other using the
same gcc and glibc core library, we found too many
programs would no longer compile or work properly
against this aging code base.
In November 2006, we utilized a one time source code
snapshot from our friends at Mandriva to pull in an
updated glibc/gcc core and associated libraries. We spent

Texstar

On May 20th, 2007, we felt we had reached a pretty stable
base and released PCLinuxOS 2007. It utilized our own
kernel from Oclient1, KDE built by MDE developer Ze,
updated mklivecd scripts from IKerekes & Ejtr, a heavily
patched Control Center, graphics from the PCLinuxOS
beautification team, and many application updates from
Thac and Neverstopdreaming. Development continues as
work is being done for a Minime release and an
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international DVD. A future release of PCLinuxOS will
feature an updated kernel, KDE 4, fresh Xorg server and
all the latest applications. All in all it has been a great
ride and we have made many friends along the way. Some
have gone on to other distributions and many are still
here from our first release. As I've always said, we're just
enjoying Linux technology and sharing it with friends who
might like it too. We hope you have enjoyed the ride as
well.

The default desktop environments are KDE 5
Plasma and Mate, but we have some wonderful
community members who have remastered LXDE,
Xfce and Darkstar (a stripped down version of KDE
5), with some available in more than one language.

Since then, of course, we’ve seen many changes.
People have come and gone, and the distro
continues to evolve and improve. The forum, as well,
continues to be a place where anyone can get the
help they need in a family setting.

Over the years, the offerings for desktop
environments has evolved. PCLinuxOS started off
with KDE 3.x. Over the years, PCLinuxOS has
featured the following desktop environments: KDE 4,
KDE 5, LXDE, Xfce, Mate, Enlightenment, Trinity,
Cinnamon, Gnome 2.x, WindowMaker, IceWM,
Fluxbox, and Openbox. Some of these have fallen
by the wayside, either no longer being offered, or
having moved on in development. Many of these are
still available for installation from a PCLinuxOS
LiveCD. Most of the others are available for
installation from the PCLinuxOS repository, installing
parallel alongside of another desktop. There are also
other less common desktop environments available
for installation besides the ones we’ve listed here.
Whatever your likes, and whatever your tastes, you
are sure to find a perfect fit for your needs.
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There is the control center to get your hands on system
control. I think this is cool because control center seems
to ease your control related work. There are vast options
which you can freely roam after installation. I would like
to mention that settings are separate from control center.
Many people will think control center is settings but it is
not. Both are different. This is a great way to keep
complex tools out of settings and ease out many tasks. The
best feature according to me in the whole distro.
As almost every Linux distro, you can also live boot in
this distro and customize options you would like and try to
use before installation.

Pinwheel from 2006

Logo from 2009

while Virtualbox to try a new distro. Chrome to surf
internet and Thunderbird to read emails.

Everyone loves to see positive comments, and the
people at PCLinuxOS are no different. We recently
got to read a wonderful review from the site
http://www.linuxandubuntu.com
(shortened
by
Meemaw)
The first thing that we all search for a distro to have is a
rock solid stable system. PCLinuxOS is a very stable
system. I tried copying files, playing songs, watching
movies on the system and all worked great. Running 6
apps together didn’t crash my system nor installing new
packages. The overall system is really stable as I
experienced last 2 days.
The system uses rpm packages which are not hard to find
and install. The system also supports APT commands
which are great to manage apps via terminal. There are
also 3 themes pre-installed which you can customize.
There are a nice set of pre-installed apps. I think this is
the 1st distro I encountered till now which has really good
selection of apps pre-installed. Do you want to play media
files? VLC is there. The online streaming of music, Spotify
got your back. Kdenlive is there to edit videos and
LibreOffice to handle documents. Bleachbit to clean junk

PCLinuxOS is one of those distros which people really
don’t know much. I felt that it is not getting that name
which it deserves. A rock solid system, nice selection of
apps, a lot of customizations and small in size and fast.
This is what any user will want from an OS.
Try it, I think it won’t disappoint you. You got my words.
DistroWatch has reviews under the distro
information, and I saw some there that really made
me happy as well:
Absolutely the best Plasma desktop I've seen yet!
AND:
This is a superb Linux OS. It is easy to install with a very
intuitive install guide. Once loaded onto your hard drive
it's a breeze setting up networking through its settings and
configuration manager. Of cos, all the usual software is
installed LibreOffice, Google Chrome web browser, and
Thunderbird email. The system is fast and stable and has
not locked up on me yet which nearly all other distros
have done.
It is very pleasant to use and has an excellent software
center to download any apps that are not installed. This is
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a pleasure to use and should be number 1 in the distro
ranks not mint. It has Kdenlive as a video editor and
Zulucrypt for encrypting a hard drive or folders.
Fast and good looking a great free OS that actually works
and not buggy, brilliant job guys.
Then, on the Everyday Linux User site, the reviewer
summarized with this:
PCLinuxOS was the first Linux distribution that really
made Linux useable for the masses...

Connect

All your
PCLinuxOS
connections in one
convenient location!

Screenshot
Screenshot Showcase
Showcase

It has to be said though that this is a really nice
distribution for the Everyday Linux User and I can
happily recommend using it as I did the last time I
reviewed PCLinuxOS.

Dobie logo

Many of us “old-timers” have used PCLinuxOS since
it’s early days and have witnessed all the ups and
downs of the distro. Through it all, this wonderful
distro has thrived, and continues to be “So cool,
even ice cubes are jealous.”
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Posted by francesco bat, September 5, 2017, running KDE.
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Feeling Safe With Your Webcam & Microphone?
by Paul Arnote (parnote)
With what I’m going to reveal, everyone will know
that I don’t “get out much.” In the past four years,
I’ve been to a movie theater once. We just don’t go.
Having a one year old infant and a four year old
toddler puts the proverbial kibosh on trips to the
movie theater. We’re not the kind of people who will
drag a screaming infant to a movie theater, only to
ruin the movie-going experience for everyone else.
In fact, the only other time we’ve been to a movie
theater in the past four years is when Cars 3 came
out. My son is a HUGE Cars fan (one of his favorite
movies, in fact), so his first experience going to a
movie theater was to watch Cars 3 the night it
opened in theaters. My daughter, yet too young to
take to a theater, stayed with my wife’s aunt.
So, with all of that in mind, I just got around to
seeing the 2016 Oliver Stone movie “Snowden.” It
was airing on the Showtime movie channel, which
we get as part of our cable TV package. The most
disturbing aspect of that movie is the breadth and
depth of the spying by the three and four letter
government agencies. And not just the NSA, but
also the FBI, CIA, GCHQ, and all the others that
make up the alphabet soup of agencies that are
charged with the task of our “security.”
But another part of that movie that scares me is how
underhanded and “slick” they are about it. One
aspect in particular describes their purported ability
to turn on a webcam without activating the camera’s
activation light (if it even has one). If you have a
smartphone, then assume your camera is always on
– even if your smartphone is “turned off.” The same
ability exists for the internal microphone of your
laptop and smartphone. Unfortunately, it isn’t just the
alphabet soup agencies you have to worry about,
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either. Numerous hacking exploits have leveraged
the webcam and internal microphone to blackmail
users over the years in a similar manner.
You are pretty much at “their” mercy when you use a
smartphone. There are exceptionally few options
available to you, other than switching to a basic flip
phone. Even then, there are no guarantees that the
camera and microphone of your flip phone isn’t
doing the same thing. If you have a phone where
you can remove the battery, that would be the best
bet to prevent any illicit use of your camera or
microphone. Unfortunately, there is a huge
proliferation of phones – especially smartphones –
where the user cannot access/remove/change the
battery. Also, removing the battery kind of goes
counter to the reason you have a cell phone in the
first place.
Just to be sure, this isn’t about whether you “have
anything to hide” or not. This isn’t about whether you
are doing anything wrong or not. This has everything
to do with being secure in your daily activities, and
about your privacy. Through your monitored
activities, “they” can get to know the intimate details
of your life – your likes, your dislikes, who you talk
to, what you talk about, how long you talk, what you
do, when you do it, where you do it, how long you
spend doing it, who you do it with, etc. You,
therefore, have nothing that remains private and
personal. In most jurisdictions, “they” don’t have a
right to have such unfettered access to those private
details of your life.
So let’s focus on your laptop with the built-in
webcam, and your desktop computer with an
external webcam attached … running PCLinuxOS,
of course. Let’s take a look at what steps you can
take to help protect yourself from the hackers and
the alphabet soup agency privacy invaders.

External webcam

We’ll talk about this one first, because it’s typically
the easiest one to thwart unauthorized access to.
Quite simply, if you can (that is, if your webcam is
hot pluggable and isn’t required to be plugged in
when you boot your computer in order for it to be
recognized), unplug it from the USB port. Problem
solved. Plug it back in whenever you need it.
But, if your webcam is not hot pluggable, then you
can put something over its lens. You can use a
sticker, opaque tape (like plastic electrician’s tape),
masking tape, duct tape, a Post-It note, etc. to cover
the lens. You could just cover the webcam with
something, like a folded up handkerchief, a towel or
washcloth, an old sock (or other article of clothing),
or just about anything else that will block the lens,
thus preventing an image from being viewed.
Internal Laptop Webcam
If you recall from last month, my trusty, clunker
Toshiba laptop fritzed out on me (and since repaired
by replacing the faulty AC power supply), forcing me
to renew the usage of my Lenovo G530 laptop. Well,
there’s one other difference between the two
computers. The Toshiba doesn’t have a built-in
webcam, while the Lenovo does.
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organization that is diligently fighting for everyone’s
digital rights and privacy.

There are a myriad of ways to disable the webcam
when it’s not in use. You could “blacklist” the
webcam driver. But that would preclude you from
using it … ever (unless you “un-blacklist” the driver
… for most users, neither action is a frivolous
matter). Some business class laptops allow the
disabling of the webcam in the computer’s BIOS.
The chances that you have one of these laptops is
slim to remote. You could have a repair shop
physically remove the webcam. Then NO ONE can
use it – not even you. Plus, you’d have a bill at the
repair shop to pay. But probably the simplest and
most effective way is to cover the webcam with tape
or a sticker. In fact, this is the method employed by
Facebook CEO and founder Mark Zuckerberg. It’s
also the method employed by former FBI Director
James Comey.

Of course, the easiest (and cheapest) way is to
simply use a child’s sticker, a small piece of black
electrician's tape, a small Band-aid, or anything else
you can stick over the lens to prevent the Peeping
Toms from taking a peek. Be mindful of the adhesive
your chosen “blind” uses. Duct tape, while it will
work, will also tend to leave behind a considerable
“adhesive trail.” The black electrician’s tape tends to
be sticky enough to do the job, but leaves behind
very little adhesive when removed (and when used
at lower temperatures, such as the use advocated
here). Plus, black electrician’s tape tends to blend in
with the black screen bezel that’s common on many
laptops. If you don’t want to look at a “glob of tape”
on your laptop’s screen bezel, then use a hole punch
to punch out a small disk of tape that you can then
center and stick over the webcam’s lens.
Microphone Security
This one might be a bit more complicated than a
webcam, as astounding as that sounds. Yes, there
have been instances where the privacy invading
alphabet soup agencies have used the built-in
microphone in computers (and smartphones) to
record entire conversations.
Chances are high that your laptop includes a built-in
microphone, especially if it includes a built-in
webcam. Look closely, because it might be difficult
to find.

EFF (Electronic Frontier Foundation) sells stickers
that you can use to cover your laptop’s built-in
webcam. The cost is a meager $5.00 (U.S.). They
have a low-residue adhesive, and each order comes
with two different sizes. You’ll have the satisfaction
that your proceeds will go to a worthwhile
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See that tiny, tiny hole, just a little off right center of
my F9 key? You guessed it. THAT is the microphone
on my Lenovo G530 laptop. Being so small, it’s
incredibly easy to overlook. In fact, on my Lenovo, I
had to search hard for it. Even after owning this
laptop for several years, I still wasn’t sure just where
the microphone was located – at least until I went on
a search for it.
Yes, you should be able to “mute” your internal
microphone. But any surreptitious user who might try
to access the internal microphone on your laptop
can just as easily un-mute that same microphone.
Things might be a little more secure by going into
the audio mixer controls of your computer and
setting the record level to zero for the internal
microphone. It would/should be a bit more difficult for
an interloper to change that level.
One other non-permanent choice might be to plug in
a dummy 3.5 mm phono plug into the external
microphone jack. On many laptops, plugging in a 3.5
mm phono plug into the external microphone jack
will disable the internal microphone. Do not trust this
method, however, until and unless you put it to the
test. If you don’t have a dummy 3.5 mm phono plug,
you can buy them at any electronics supply house
for very, very little money. You could also go the
cheapest route, and just cut off a 3.5 mm phono plug
from a pair of broken headphones. It should be
enough to cause the internal microphone to be
disabled, if your laptop is setup to do so.
A more permanent solution exists, but only if you
fancy yourself to be rather handy with being able to
take apart your laptop – and get it back together
again. If you open the case of your laptop, you can
find the wires leading to the internal microphone and
cut them. From that point forward, the ONLY access
you (or anyone else) will have to a microphone will
be through the external microphone jack. Of course,
if you aren’t handy or comfortable taking apart (and
putting back together) your laptop, there is always
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the local computer repair shop. I’m sure they’ll
accommodate your request, for a fair price.
Summary
In today’s environment of governmental spying
agencies and hackers, the responsibility for
protecting your privacy exists only with you. As much
of a cat and mouse game as it is, you can’t be too
careful in protecting your privacy. For sure, they
don’t have any concerns for your privacy. They are
only interested in collecting all the data they can
about you. YOUR data is the currency of the times.
Each snippet of data might seem to be insignificant
and innocent, but put together with other little
snippets, it can be more revealing than you can
imagine.

Screenshot
Screenshot Showcase
Showcase

I’ve said it in the pages of this magazine before, and
I’ll say it again: just because you can, doesn’t mean
you should. Those who are hell bent on collecting
your data have never heard this maxim. Thus, the
entire responsibility for protecting your data and
privacy rests completely with you.

Linux Docs
Linux Man Pages

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos
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Posted by jogurtmen, September 16, 2017, running MATE.
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Inkscape Tutorial: Draw A Cartoon Turkey
by Meemaw

For the beak, draw a small triangle with a shade of
yellow fill and black stroke. I also grabbed the top
line and curved it a bit.

Rotate them around and duplicate once for the other
side, then place the wings.

Turkeys have a “beard” or snood under their beaks. I
drew this with the Bezier tool, moving the nodes to
edit it the way I wanted it, but you could use the
Pencil tool as well.

If you have the body and face the way you want
them, you could choose them all and Group them
(or not), but be sure and save your work. Now let’s
get busy on the feathers. To create the feather
shape, start with a long oval. When you get it drawn,
choose Path > Object to Path.

I found a fun tutorial the other day, and since
Thanksgiving is coming up soon for many of us, I
thought it would be fun to do a turkey. I’m sure you
have done something this easy already, but we’ll use
some of the skills we’ve learned over the years.
Open Inkscape and a new canvas, and start by
creating a couple of circles. Make the fill brown with
a darker brown or black stroke. You can create the
first circle and then use <CTRL> + D to duplicate it.
After you do that, make one of the circles smaller
than the other. Open your Align & Distribute
window and align the two circles vertically. Now you
have your body and head.

Now use the Nodes tool again to add a couple of
nodes to one end so we can make it a bit different.

Now draw two circles with white fill and black stroke
for eyes. Also, add a black circle to each. Use Align
& Distribute to line them up as well.
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Also, for wings, create a zig-zag with the Bezier tool.
Choose Path > Object to Path, and curve the lines
until you have 3 smooth curves. Fill and stroke it with
the same colors as the body.

For the finishing touch, use the Pen tool or Bezier
tool to draw a simple line down the middle of the
feather. I made mine a shade darker than the feather
color. Group these two when you’re finished, and
also move the point of rotation to the right side of the
feather.
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With the feather group selected, we’re going to Edit
> Clone > Create Tiled Clones.
Now, change the following settings:
Shift X Per column to -100%
Scale X Per column to 5%
Rotation Angle Per column to 10 degrees.
Rows, columns to 1 and 11
When the settings are set, click Create. You should
get the following:

We need a circular wedge to use for shading, so
position them as shown below. Select both of the
circles choose Path > Difference.

The shape you’ll get is a wedge that can fit at the
bottom right of the face. Give it an Opacity of about
50%. Make sure the beak and snood are brought in
front of the shadow.

Now, select the bunch of feathers, and group them.
Duplicate the group and flip the duplicate
horizontally. You can do this as many times as you
need to, in order to make the feathers as full as you
want. I think I made extra, but I like the result. You
will have to rotate them and line them up in the
center, then position them behind the body.

Do the same to the body. You can also add a drop
shadow to the grouped, finished turkey (right, top).
If you want to, you can add a background (right).
I hope you like the way yours turned out.

For the feet, simply use the Pen tool and draw a few
lines to make feet. Group them and duplicate, then
flip the duplicate horizontally. Position them at the
bottom.
We need to do some shading to finish. Draw a
couple of circles, or ungroup and duplicate one of
the ones you made for the head or body. I made one
just a little darker than the turkey color.
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PCLinuxOS Recipe Corner
5. Mix milk, cornstarch and basil; stir into tomato
mixture in skillet. Heat to boiling, stirring constantly.
Boil and stir l minute. Stir in mushroom mixture; cook
until hot. Serve over chicken and fettuccine.
Tips:

Fettuccine with Chicken and Sun-Dried Tomato Sauce
Ingredients
1/4 cup coarsely chopped sun-dried tomatoes (not
oil-packed)
1/2 cup chicken broth
4 ounces uncooked fettuccine
1/2 cup sliced mushrooms (1 1/2 ounces)
2 medium green onions, chopped (2 tablespoons)
2 cloves garlic, finely chopped
2 TBSP dry red wine or chicken broth
1 tsp vegetable oil
4 boneless, skinless chicken breast halves (about 1
pound)
1/2 cup milk
2 tsp cornstarch
2 tsp chopped fresh or 1/2 teaspoon dried basil
leaves

4. Heat oil in skillet over medium heat. Cook chicken
in oil 3 to 4 minutes, turning once, until brown. Add
tomato mixture. Heat to boiling; reduce heat. Cover
and simmer about 10 minutes, stirring occasionally,
until juice of chicken is no longer pink when centers
of thickest pieces are cut. Remove chicken from
skillet; keep warm.

--- Prepare this recipe using spinach fettuccine in
place of the regular fettuccine for a pretty
presentation.
--- Cut tomatoes with kitchen scissors before rehydrating in broth.

Linux Docs
Linux Man Pages

Directions
1. Mix tomatoes and broth; let stand 30 minutes.
2. Cook and drain fettuccine as directed on package.
3. While fettuccine is cooking, cook mushrooms,
onions and garlic in wine in 10- inch nonstick skillet
over medium heat about 3 minutes, stirring
occasionally, until mushrooms are tender. Remove
mixture from skillet; set aside.
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ms_meme's Nook: The Birth Of PCLinuxOS

Tex had a crazy desire

From those Texas hills

To build a Linux empire

He gave us thrills

And he made that the start

With what he wrote

Of PCLinuxOS

Did it all alone
Never ever had one banknote

He was bold and inspired

Then he produced it introduced it

Wrote code never tired

Gave the news to the press

And he made that part

That he'd given birth

Of PCLinuxOS

To PCLinuxOS

MP3
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Disclaimer
1.

All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2.

The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3.

The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5.

Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Screenshot
Screenshot Showcase
Showcase

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Posted by Mr Cranky Pants - YouCanToo, September 23, 2017, running KDE.
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LyX: A Visual Approach To Typesetting In TeX
by phorneker
Up to now, we have used TeXmaker for editing TeX/LaTeX documents. While
TeXmaker is a great editor for typesetting documents, there is another application
in the PCLinuxOS repository that takes typesetting to the next level of simplicity.
LyX takes a WYSIWYM (that is What You See is What You Mean) approach to
typesetting. That is, when composing and editing documents, you get an idea of
what the document is going to look like (without having to rebuild the document to
see the changes). This is simpler than TeXmaker in the sense that you are editing
the document without having to learn the TeX/LaTeX language.

development environment for TeX and LaTeX in the sense that when you edit a
document, you immediately see the changes to the document, whereas when
you make changes to a TeX document in TeXmaker, you need to rebuild the
document to see the changes in the preview panel.
As I mentioned in the Introduction to TeX/LaTeX article, TeX was designed as a
typesetting language. This means that you as a writer and publisher can focus
more on the actual content of the document and less on the details of formatting
the text in the document.
As we scroll through the Introduction, we can see some things that differentiate
LyX from typical word processing applications, starting with this one:

When installed from the repository, LyX is launched from the Office menu inside
the main menu (or Applications menu depending on what desktop you are
running). When launched for the first time, you will get an introduction to LyX
(which is itself editable).

The highlighted foot * indicates that there is a footnote attached and that footnote
will appear at the bottom of the page when printed. Clicking on the footnote
reveals the following:

In this case, it is a reminder that there is a mailing list for the LyX Documentation
team. The hyperlink provides a clickable link on the PDF version of the document
when that document is published.
First, LyX is not a word processing application similar to AbiWord, Focus
Writer or the word processing component of LibreOffice. It is instead a visual
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Clicking on Table of Contents here, will open a left side panel providing you with
an outline of the document you are publishing (next page, top left).
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Section 2.3 of the LyX Introduction contains a list of the included
documentation, and those documents are accessed through the Help menu.
Be sure to read at least the Tutorial and the User’s Guide so you get an idea of
how LyX works and what you can do with it.
At this point, we should close this window (by holding down Control and then
pressing the F4 key or by selecting Close from the File menu).

There is a section, namely 2.3 The Manuals, that contains a listing of the
documentation included with the application.

This is what we normally see when we launch LyX (after the first time). LyX
comes with some templates that you can use to start a new document, or you
can simply start with a blank document.
Holding down Control and pressing N will start you with a blank document.
However, if you want to use one of the templates included with LyX, then hold
down both Control and Shift, and then press N (next page, top left).
Templates are stored in /usr/share/lyx/templates and are available to all users
of LyX on your PCLinuxOS installation.

It is really a good idea to actually read the documentation that comes with LyX,
especially the Introduction, which should already be on screen when you
launched LyX for the first time.
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If you want to write a letter, there are three templates for this purpose. The
template named letter.lyx is intended for letters written in American English (or
Canadian English), whereas lettre.lyx is intended for letters written in other
languages (including British English). The frletter.lyx is intended for letters
written in French (including Canadian French).
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The template definitely looks like something used to format articles for
publication. There are places to enter the title, date, and author as well as an
abstract of what the article is about.
Here is an example of the visual approach to typesetting. In LyX, you are using
TeXlive to build the document, yet you do not have worry about TeX commands
or statements. Those are kept internally within LyX. You simply focus on the
content.
Documents in LyX are saved with the .lyx extension rather than the traditional
.tex or .ltx extensions normally found in TeX and LaTeX documents.
This is one way to distinguish documents that were created with LyX from
documents created with another editor such as TeXmaker.
Also, it is a good idea to store LyX documents in a separate (preferable empty)
directory to keep your work organized in your user space on your PCLinuxOS
installation.
You can hold down Control and press S to save documents in LyX.
Each of these templates is self documenting as to their intended usage. For
example, let us look at DocBook_article.lyx.

To use this template for your documents, you will need to give your document
another name. To do this, select Save As… from the File menu, or hold down the
Control and Shift keys and press S, then type in a new name for the document
and click on OK.
Then, within the document, replace Title with the title of your document, replace
Date with the date of the document (usually today’s date), and replace Joe Doe
with the author’s name (usually yours).
The instance of Abstract just above where it says First Section is where you
replace the word abstract with the actual abstract of the document you are about
to type. The instance of Abstract just below the author’s name should be kept as
is as this is the header we use to tell the reader that the following is an abstract of
what the document is about.
File Types that can be imported to LyX
In addition to creating a new blank file by typing Control-N, and creating a new
file from a template by typing Control-Shift-N, LyX can import existing
TeX/LaTeX documents, spreadsheets, and plain text files (next page, top left).
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Let Us Use Last Month’s Example
In the last article, I brought in Mathematical Approach to Photography for a
sample document. Since this is a LaTeX document, we can bring it into LyX with
the File → Import command from the main menu.

Select Import from the File menu to get this list of file formats supported by LyX
for importing.
The CJK LyX 1.4.x formats refer to documents written in Chinese, Japanese and
Korean using LyX 1.4.x.
LyX will import Excel, Gnumeric, and LibreOffice spreadsheets (with the
OpenDocument spreadsheet) format as well as databases and tables saved in
CSV format (for Comma Separated Values).
Existing LaTeX documents can be imported by itself, or pasted from the clipboard
(copied from the source document with another program).
Plain text can be imported as well. The Join Lines… option allows for lines of
text in the source file to be read as one line in LyX until a blank line is
encountered, at which time, a new line in LyX will begin. Remember that TeX
treats one whitespace element (such as a blank space or a return carriage
character) the same as a thousand whitespace elements. Without the Join
Lines… option, the plain text is read in verbatim, and the result could be a mess
for you to clean up in LyX.
For those of you not familiar with the CSV format, CSV is simpler than it appears
to be. It is simply a representation of a table where each line in the CSV file is a
row, and each cell in the row is separated by a comma (and a blank space
following). Usually, the contents of each cell are enclosed in quotes.
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As we can see here, we are going to need to clean up this imported document as
there are a few elements missing here that were in TeXmaker, such as the title
that was in the original document.
For starters, we need to replace the \maketitle command embedded here to the
actual title of the document. Let us highlight \maketitle, delete it and then replace
it with the actual title of the document.
The toolbar has a pull down menu that allows you to
quickly select document elements. Fortunately, this
menu has a Title element we can use here (in
addition to the Author and Date fields).
We simply make the appropriate replacements (next
page, top left).
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The lines around the table are still there, but there is a LyX notation indicating the
amount of whitespace used between the text and the table. Hence, the import
here was done correctly. The LyX notations will not appear in the printed version
of this document. They are there to remind us of the formatting of this section.
Also note the presence of a footnote. Click on that footnote to see the contents of
that footnote.
Now, let us scroll down to the Focal Length section. Remember the formula we
typeset in the last article? Here it is in all its glory already typeset in LyX.

Looks better, doesn’t it? We could place an abstract later if we wish. Now let us
scroll down to the section called How Big is That Photograph? to find out what
happened with the import.

...and here is the formula itself.

...and finally, the graphic we used in the article appears in LyX as expected (next
page, top left).
Now, we can just type Control-S to save the document as we have it here.
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The button next to that is used to insert graphics such as the one we used
towards the end of the document.
Next to that is the button to (visually) insert tables into the document.
The last three buttons are used to show the outline, the math toolbar and the
table toolbars, with the latter two appearing at the bottom of the application
window.

This toolbar has some important functions that affect the document. The first is a
document preview. LyX uses Okular for the document preview.
The next button updates the resulting PDF without the preview.

The Toolbars

Larger TeX projects involve a master document. This document not only contains
content local to that document as well as commands for TeXLive to include (and
process) associated documents. The function here is similar to the function of the
#include statements in C and C++.

LyX has some toolbars that are feature packed.

The next two buttons update the master document. Icons with the eyes on them
launch Okular for the document preview, whereas the icons with the arrows
simply update the master document.

This toolbar is located directly below the main menu of LyX. The first item here is
a popup menu to quickly select often used document elements such as
sectioning, titles, dates, and chapters.

The next icon with the one arrow and a smaller document icon toggles between
forward and reverse search in LyX for the current document being edited.

Next, we have the customary New Document, Open Document and Save
Document buttons, as well as the spell checker buttons, undo and redo buttons,
cut, copy and paste buttons, and search document buttons as expected of any
editor or word processing program.

The last two icons update are similar in function to the first two icons. The
difference here is what command LyX uses to typeset the pages. The default for
LyX is to use pdflatex, that is direct typesetting of the pages to a PDF file.
The Update Other Formats and Preview Other Formats commands in LyX
refer to the output format for the document.

The A button with the accent toggles the emphasis attribute on highlighted text
(usually italicized). The button next to that is called the Toggle Noun button
(Why? I’ll never know). The third A is called Apply Last and refers to styles of
text (such as boldface, italics, and font change) that were previously applied to
text in the document.

Besides PDF, LyX can output to DVI (using the latex command), PostScript,
HTML (either through standard HTML or optimized so what appears in the web
browser is similar to what appears in LyX itself), OpenDocument or Rich Text
Format.

The Sigma character next to that toggles the Math mode and Math Mode is
needed to typeset mathematical formulas.

PDF file is generated with the pdflatex command by default. LyX can, however,
use the standard latex command to produce PostScript first, then use the ps2pdf
to generate the PDF file.
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The main difference here is that pdflatex optimizes the TeX output for PDF rather
than just translating PostScript to PDF, resulting in a better quality PDF
document. It may not be apparent for simple TeX documents, but for more
complex TeX documents, the difference will be clear.

Next to that is the button to include citations in your document. Citations are
needed to include sources used in production of the document, (i.e. the sources
from which you paraphrased or quoted the text in your document so that the said
text is legal for use).
The next button is used to insert an index entry so when the document is built,
there will be a index page typeset within the document.

This toolbar is for inclusion and formatting of lists in your document. From left to
right, the first button reverts highlighted text in a list back to plain text (that is no
formatting).
Next, this button creates a numbered list with each line in the highlighted text
being an item in the list. You can also start a numbered list with this button by
placing the cursor where you want to start the list, then click on this button.
The button next to that does the same thing, only the list is bulleted (with a round
bullet) instead of a number for each item.
The next button creates generic lists, that is items are simply listed without any
type of bulleting.
Then we have a button that creates lists intended for terms and their definitions.
The last two buttons are used in creating multi-level lists. Items to be placed in
sublists are highlighted and the buttons move the items into or out of the sublists.

The following button inserts a nomenclature entry in your document. The
Merriam-Webster Dictionary defines nomenclature as follows:
Definition of nomenclature
• name, designation … the changing nomenclature of her streets is even more
baffling … — Cornelia O. Skinner
• the act or process or an instance of naming nomenclature … is at its simplest
the task of assigning a name to each distinct species — R. I. Smith
• a system or set of terms or symbols especially in a particular science,
discipline, or art the nomenclature of inorganic chemistry: an international
system of standardized New Latin names used in biology for kinds and groups
of kinds of animals and plants
To define a nomenclature entry, place the cursor on the word being defined and
click on that nomenclature button. Type in a description of what that particular
word means in the sentence and click on OK.
Next to that is a button for insertion of footnotes in your LyX document. Footnotes
appear as a symbol in your document, but are typeset when the document is
typeset for publication.

Finally, this toolbar contains buttons that allow you to work with tables, graphics,
footnotes, hyperlinks, cross references, labels, citations, indexes, and even
attach other documents.
The first two buttons insert floating graphics and tables into the document.
Elements in LyX that float in the document can be shown or hidden within the LyX
editor, and show up when the document is being typeset.
The third button is for placing labels in the document. Labels here are nothing
more than bookmarks that are kept internal to LyX and are referenced when
necessary.
The next button is for making cross references within the LyX project. Here is one
application for labels in LyX documents and projects.
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The button next to that does the same for margin notes. Margin notes appear in
small type between the margin of the document and the edge of the paper
closest to the margin. Here is another reason why TeX documents have a default
two inch margin for printed pages.
The button next to that is for general notes that are maintained within the LyX
document. These are readable only in the editor and are similar to comments
embedded in documents on Google Docs (except for the fact that they do not get
e-mailed from within LyX).
The button next to that creates a box where you can enter text to be enclosed,
not unlike the table style I use in these articles. Boxes can be enclosed within
other boxes.
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The button following that inserts a hyperlink. This is normally used for documents
that are going to be published in PDF or HTML format.
The button with the abc on it allows you to change the style of text highlighted, or
the style of what you will be typing in.

Series allows you to select between Medium (or normal for most of us) and Bold
for boldface type.

Here is one place where LyX has an advantage over TeXmaker. Text Style
allows you to set parameters to text that you are going to insert, or have already
highlighted.
Clicking on Apply Changes Immediately and then clicking on Apply allows you
to see your changes before making the commitment to those changes in your
document.

Shape allows you to select Upright, Italic, Slanted, or Small Caps. For some
fonts, such as Times New Roman, there is a big difference between Slanted and
Italics. Slanted simply slants normal text, whereas Italics provides the truly
italicized version of Times New Roman.

For fonts, you can choose between Roman, Sans Serif, or Typewriter (for
monospace text), or you can reset the font in the text to plain (i.e. default font)
text (right, top).
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...and as we can guess, Color and Language effect just that, Color and
Language. For the Color, we get the standard set of sixteen colors in which to
color text.
Note: This cannot be easily done in TeXmaker unless we have the right LaTeX
package that provides color support. Herein lies an advantage of LyX over
TeXmaker.

The PCLinuxOS Magazine
Created with Scribus

Let us go back to the toolbar. The button with the paragraph symbol allows you to
set parameters for the affected paragraphs.

Here, we can choose the spacing between lines in the paragraph (Single, 1.5
lines, or Double), whether to indent the paragraph or not, and how the
paragraph is justified.
What I just showed you is the basics of LyX as a development environment for
TeX/LaTeX documents without having to learn a line of TeX code.
The real power of LyX comes when we actually use LyX to edit documents like
last month’s real world example.
Feel free to explore the templates that come with LyX, and explore the
documentation that comes with the LyX package.
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MultiCD: Finally, A Multiboot That Works
by Alessandro Ebersol (Agent Smith)

What is the MultiCD?
It is a shell script designed to create a multiboot CD image containing various
distributions and/or different Linux utilities.
How does it work?
MultiCD has a collection of plugins, scripts that help to identify the iso's that will
integrate the project, and build a resulting ISO that works.
Currently, 108 ISOS are recognized among Linux distros and some Windows
installations.
More plugins are added over time, so to always have the updated script is the
best practice.

Having several ISOs, several distros, whether Linux or even Windows installation
disks, all combined in a single ISO, always been something very sought for us,
PCLinuxOS users.
But, to find a software that could do this was, ahh, a major challenge.
Options abound, but finding one that works …
I tested Yumi, from Windows, via Wine, but it doesn't work (corrupts the ISO
when closing the session), then I tested MultibootCD, and the part of making
several ISOS does not work and does not give an error message. For one ISO
only it works fine, however. I also tried unetbootin, which recently stopped
working in PCLinuxOS. Then, in my research on how to make an ISO with
multiple distros, I came across MultiCD, at URL: https://multicd.us.
I was pleasantly surprised. A simple script that does what it promises, without any
problems and easily.
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More than one type of ISO of the same distribution can be integrated into the
resulting project. In PCLinuxOS, for example, four different ISOs are recognized
by the script: PCLinuxOS KDE, Mate, LXDE and generic iso pclos.iso. For all
supported ISOs click here.
Creating a multiple ISO, with several Iso's/distros
To create a multiple ISO, the instructions are as follows:
First,
download
the
MultiCD
script,
at
this
link:
https://github.com/IsaacSchemm/multicd/archive/master.zip. You may want to
place the downloaded file in its own directory.
Second, unzip the zip file. It will automatically create a multicd-master folder in
the location where the zip file was downloaded.
Now, you should put in that folder the ISO's you want to use to mount the multiple
ISO, copy them to the folder, or, if you're low on disk space, put symlinks to these
ISO's.
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You now need to give execute permission to multicd.sh script (chmod + x)

The whole process is automatic.
After a few minutes, the resulting ISO will be ready, inside the /build folder, within
the folder multicd-master.
This ISO will be called multicd.iso, and is ready to be burned to a blank DVD, or
with the DD-Copy program (or DD command) be installed on a USB stick, and it
certainly will work.
MultiCD6.png

Now, just type ./multicd.sh and the script will begin its work.
Floppy disk images and hard disk images are also supported (.img or .imz
extensions).

Limitations
The script does not create images compatible with EFI boot, so you must set the
machine to boot legacy/BIOS, and the image will work.
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The image created does not allow writing in the same media (if it's a DVD, no
problems, but if it is a USB stick/external hard drive, the multicd.iso renders it
read-only, the whole disk/usb stick).


The PCLinuxOS Magazine
Special Editions!

Conclusions
The script did not work with me the first time I used, it gave an error at the end,
when the script accessed the isohybrid program to create a bootable ISO on flash
drive and DVD. I contacted Mr. Isaac Schemm, the creator of the script, and 24
hours later he fixed the problem, creating a new version that works perfectly in
PCLinuxOS, creating bootable ISO's in any media (CD, DVD, USB key, etc.)
This is one of the benefits of free software: access to developers, which brings
together users and creators, improving interchange between those who use and
those who create. I thank here Mr. Isaac Schemm, he promptly changed the
script to make it work in PCLinuxOS. Many thanks.
And now there is an option that actually works to create multiple ISO's in a only
one CD/DVD/USB key on PCLinuxOS.
Now, enjoy MultiCD booting in PCLinuxOS!

Get Your Free Copies Today!
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Repo Review: Converseen, A Batch Image Processor
by CgBoy
This month I’ll review a program in the repository
called Converseen. Converseen is a batch image
processor. It allows you to resize, rotate, flip, and
convert many images at once. It could be very useful
if you had a whole lot of images that needed resizing
or converting into a different format.
When you add images into Converseen, they’ll
appear in a box on the right of the window. There
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you can check or uncheck the images you want to
change. A preview of the currently selected image is
on the left, along with some information about the
image size, format, etc.
Converseen can convert images into over 100
different formats. These would of course include the
most popular formats, like .jpg, .png, .gif, etc. There
are some compression settings as well. If you have
some semi-transparent images loaded into
Converseen, you can then change the color of the
transparent areas.
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At the left side of the window, below the image
preview, are the image scale, resolution, and
rotation settings. When changing the image scale,
you can set it to keep the aspect ratio of the image.
The images can be rotated 90 or 180 degrees, and
flipped vertically or horizontally. Below those settings
are the image saving options. From there you can
set the output directory, or just use the same location
as the images. And you can choose to rename the
images, or just overwrite the original files.
Converseen can also import a PDF file, and load the
images embedded in the document. Converseen is
supposed to be able to import .ico icon files, but for
whatever reason, it would cause the program to
crash every time I tried. I’m not too sure how useful
these two features are though.

Screenshot
Screenshot Showcase
Showcase

Summary
So, what do you think of Converseen? I think that it
could be extremely useful for easily converting many
images at once, or scaling them down so they’ll take
up less disk space. It’s well designed and easy to
use. Whether or not I actually have any use for the
program, I don’t know. But for those who do, I
recommend it. Oh, and I apologize for this article
being so short; there just isn’t that much to say
about a batch image processor!

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

Posted by OnlyHuman, September 17, 2017, running e22.
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Pause, Then Resume, A Process On Linux
by Paul Arnote (parnote)
If you’ve spent any amount of time on the command
line, I’m certain that the following has happened to
you. Let’s say you start a “process” that tends to
take up a lot of time. That process also consumes a
lot of resources. But, you also have other things you
need to get done, and you need those resources, at
least temporarily.
You could just let the lengthy process continue until
it is finished. But, you can also temporarily stop that
process, and resume it after you’ve finished the
other things you need to get done. Keep in mind that
this only works for the current session, and will not
transfer between a reboot or restart.
The best way to explain how this works is to provide
an example. Let’s say that we used the wget
command to download the LXDE Mini PCLinuxOS
community ISO (entered all on one line, of course).
wget
http://pclosusers.com/communityiso/LXDE/com
munity-pclinuxos64-LXDE-mini-2017.09.iso &

We put the “&” at the end of the line to force the
wget command to execute in the background.
Now, run the ps command.
[parnote-lenovo@localhost ~]$ ps
PID TTY
TIME CMD
6464 pts/0
00:00:00 bash
18983 pts/0
00:00:00 wget
19015 pts/0
00:00:00 ps

Note the PID of the process for wget. We will need
the PID to pause the wget process.

At the command prompt, enter the following:
kill -STOP 18983

The “18983” parameter is the PID for the wget
process, which we noted when we ran the ps
command. You will get a confirmation message that
the wget process has been stopped. You can check
in your graphical file manager by highlighting the
incomplete download, and you will notice that the
filesize is no longer increasing.
When you are ready to resume the wget process,
enter the following command:
kill -CONT 18983

PCLinuxOS Magazine

The wget process will graciously pick up right where
it left off, and complete as if you never paused it.
This probably isn’t going to work very well with GUI
processes. As you might notice, GUI processes
never even showed up in the list produced by the ps
command. GUI processes will show up though, if
you issue the ps command with the -A flag (ps -A). I
wouldn’t be eager to try it however, as this method
works primarily with tty processes.
Isn’t it nice to be able to have full and complete
control over your Linux machine? Now, you can
pause those lengthy processes, then resume them
when you are ready.
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PCLinuxOS Family Member Spotlight: wyohman
As told to YouCanToo

Where do you call home? What is it like? IE:
weather, scenery
San Angelo, TX - Semi-arid, West Texas desert.

What is your name/username?
My real name is Bill Yohman. My forum name is
wyohman.
How old are you?
52 years old.
What kind of things you like doing? hobbies,
travel, fishing, camping?
I have expensive hobbies: cars, guns, bicycles and
computers.

Are you married, single?
Married.
How about Kids, Grandkids (names and ages)?
I have two kids: Mikhail, 28 and Jasmine, 25 and
one granddaughter - Ellie, 3.

Why and when did you start using Linux?
I've been using Linux since mid-1992 before kernel
1.0 (Yggdrasil, Slackware, etc). Full time Linux user
since 2000 (Mandrake/Mandriva/PCLinuxOS).

Do you have pets, what is your favorite?
I have two cats and a dog. I'm more of a cat person.

What specific equipment do you currently use
with PCLinuxOS?
Shuttle SH170, 32GB, Samsung 950Pro
Dell 6540 laptop, 16GB

Are you retired, still working and if working, what
do you do?
Retired from the Air Force (26 years) but I'm
currently a Cisco network engineer for a Managed
Services Provider.

Where did you go to school and what is your
education level?
Born and raised in East Texas, but received my
Bachelors in Electronics Management from
Southern Illinois University @ Carbondale (right,
top).
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What would you like to see happen within
PCLinuxOS that would make it a better place.
What are your feelings?
Support for new hardware and repo status are my
main areas. I like to see new package requests &
updates put in the repo on a timely basis. I think they
do a pretty good job.
PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum member. This column will allow "the rest of us" to
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PCLinuxOS Family Member Spotlight: wyohman
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

Linux Training
Courses & Classes

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Screenshot
Screenshot Showcase
Showcase

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
PCLinuxOS Magazine

Posted by sammy2fish, September 5, 2017, running KDE.
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Tip Top Tips: Mass Removal Of The
Executable Attribute From Files
Editor’s Note: Tip Top Tips is a monthly column in The
PCLinuxOS Magazine. Each month, we will feature – and
possibly even expand upon – one tip from the PCLinuxOS
forum. The magazine will not accept independent tip
submissions specifically intended for inclusion in the Tip
Top Tips column. Rather, if you have a tip, share it in the
PCLinuxOS forum’s “Tips & Tricks” section. Your tip just
may be selected for publication in The PCLinuxOS
Magazine.

current directory and will remove the 'executable'
attribute from all files (in filesystems where this is
supported, like ext2, ext2, ext4).
find . -type f -print -exec chmod -x "{}"
';'

Note that if you remove the 'executable' attribute
from a folder (directory) entry, the folder is no longer
accessible. The above command will only affect
'regular' files (-type f option).

This month’s tip comes from PCLinuxOS forum
member dm+.

pags added:

I have lots of files coming from DOS/FAT/NTFS etc.
filesystems which are marked with the 'executable'
attribute.

Bear in mind this is not changing the files while they
are still on the DOS/FAT/NTFS etc. filesystems. This
is after they've been moved to a filesystem that
supports the attributes (ext2/3/4, btrfs, jfs, xfs, etc.).

The following command (entered all on one line) will
process the file system sub-tree starting at the

Support PCLinuxOS! Get Your Official

PCLinuxOS

Merchandise Today!
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PCLinuxOS Bonus Recipe Corner
Arrange apple wedges over brown sugar mixture,
overlapping tightly and making 2 layers if necessary.

Caramel-Apple Upside-Down Cake
INGREDIENTS

INSTRUCTIONS

Topping

1. Heat oven to 325°F/165 C Spray bottom and
sides of 8- or 9-inch square pan with cooking spray.

1/4 cup butter or margarine
2/3 cup packed brown sugar
1/2 teaspoon ground cinnamon
2 medium apples, peeled, cut into 1/2-inch wedges
Cake
1 1/3 cups all-purpose flour
1 teaspoon baking powder
1/2 teaspoon ground cinnamon
1/4 teaspoon salt
1 cup granulated sugar
1/2 cup butter or margarine, softened
2 eggs
1/2 teaspoon vanilla
1/4 cup milk

2. In 1-quart saucepan, melt 1/4 cup butter over
medium heat, stirring occasionally. Stir in brown
sugar. Heat to boiling; remove from heat. Stir in 1/2
teaspoon cinnamon. Pour into pan; spread evenly.

3. In medium bowl, mix flour, baking powder, 1/2
teaspoon cinnamon and the salt; set aside. In large
bowl, beat 1 cup granulated sugar and 1/2 cup
butter with electric mixer on medium speed, scraping
bowl occasionally, until fluffy. Beat in eggs, one at a
time, until smooth. Add vanilla. Gradually beat in
flour mixture alternately with milk, beating after each
addition until smooth. Spread batter over apple
wedges in brown sugar mixture.
4. Bake 55 to 65 minutes or until toothpick inserted
in center comes out clean. Cool on cooling rack 15
minutes. Meanwhile, in medium bowl, beat whipping
cream on high speed until it begins to thicken.
Gradually add 2 tablespoons granulated sugar,
beating until soft peaks form.
5. Run knife around sides of pan to loosen cake.
Place heatproof serving plate
upside down over pan; turn plate
and pan over. Remove pan. Serve
warm cake with whipped cream.
Store cake loosely covered.

Whipped Cream
1 cup whipping cream
2 tablespoons granulated sugar
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ms_meme's Nook: PCLOS Bound

I'm PCLOS bound
No more with Windows hangin' round
I've found the hottest OS on earth
for what it's worth
Texstar from Linux just gave birth

I'm PCLOS bound
Praise in the forum hear that sound
The coolest OS they proclaim
of its fame
PCLOS love the name

He is my hero
PCLOS you will love it so
I'm telling everyone who I know
What I've found
I'm PCLOS bound

Tex is my hero
PCLOS you will love it so
I'm telling everyone who I know
What I've found
I'm PCLOS bound

MP3
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Security Breach At Equifax
& Lessons To Learn From It
by phorneker
I first heard about the network breach at Equifax
from watching the September 8 episode of CBC’s
The National on YouTube. My first thought was “this
could not be happening”, especially in the era of
news where distinguishing truth from fiction is
difficult. Then yesterday, I got an e-mail from my
bank regarding the breach. Then, I decided to
investigate this for myself.

The rumors were confirmed true with a visit to
Equifax’s
website.
(Source:
http://www.equifaxsecurity2017.com)
Before Equifax transitioned its credit reporting
services to an online only operation (starting in
1998), one could go to a local credit bureau and get
a credit report. Back then, you could pay $8.00 for a
copy of your Equifax report, and if you had been
denied credit in the past sixty days, that report was
free.
From 1993 to 1998, I worked in one of those local
credit bureaus, first as a data entry clerk in charge of
public records, as well as having been the
Information Technology person for the local bureau.
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Among things I accomplished here was the
development and maintenance of credit reporting
software (as a stand alone application, and as
software to report data from customer databases).
When I first came to the local bureau, our setup was
a
network
of
3270-compatible
terminals
manufactured by Harris Technologies (the 9100
series) connected to a hub where the configuration
of the 3270-compatible terminals and the hub was
stored on a single 5.25 inch floppy disk. The hub
communicated to the Equifax network through a
dedicated phone line and a 56k modem. There was
also a line printer connected to the hub, and was
about the size of a vanity fixture for a small
bathroom (cabinet included). The paper (11 x 17
inches) was fanfold and was fed from underneath
the printer.
In 1996, that setup was replaced with a 75Mhz
Pentium machine for the hub, running OS/2 2.1, and
50Mhz 486 systems for the workstations, all
equipment IBM branded with the workstations
running PC-DOS 6.3 and custom 3270-emulation
software. The machines had Windows 3.11 installed,
but Windows was never used. The printer was
replaced with a standard IBM branded printer that
had a wide carriage. That printer was connected to a
workstation where consumers came in to get their
credit reports.
At that time, my home machine was a Compaq
Presario 425 running OS/2 Warp 3.0, and this was
two years before I started using Linux (with Red Hat
5.2).
The bureau where I worked was also a collection
agency, and the computer setup there was a Digital
(now HP) PDP-11 running Digital UNIX for the
operating system and FACS for the collection

software. Users interacted with it through Televideo
terminals (VT-100 compatible). In addition, there
were two internal networks running Netware 3.x.
One of those was for general business use with
various 486 machines running Netware 3.x on
Windows 3.11, and a single HP Deskjet 870cse for
shared printing. The other was a single server, an
AcerFrame 500 running Netware 3.x with three
workstations connected to it for processing of
mortgage applications. The workstations were 386
machines that I rebuilt with the operating system and
networking software on a single floppy. (This was an
early version of the thin client concept for networking
computers.)
When the office closed down, I got the AcerFrame
500 and the DeskJet 870cse as part of my
severance package. It was this machine that I rebuilt
from a mortgage processing server into a Red Hat
5.2 workstation. (I had to install a CD-ROM drive in
order to install Linux.)
...and that was my working relationship with Equifax.
Today, I checked out the job offerings in their IT
department and learned that Equifax deemphasized
the IBM mainframe and focused more on Web
technologies, using a combination of Oracle (for
Java and OracleDB) and Microsoft products
(specifically the .NET framework).
In my opinion, the Equifax system was far more
secure back in the 1990s when credit files were
stored on IBM mainframes and accessed through
custom software, than the solutions implemented by
Equifax today. Knowing the reputation of C# and the
.NET framework, using C# was quite a risk itself in
terms of security, let alone stability.
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Security Breach At Equifax & Lessons To Learn From It
We have Java in the PCLinuxOS repository, and it is
quite secure and stable, so we can rule out Java
itself as a factor in what happened with the security
breach.
Then comes the question of how often Equifax’s IT
infrastructure is kept up to date. In the past few
issues of this magazine, we have emphasized the
importance of keeping our systems up to date and
secure (including the advice discouraging third party
software installation).

I cannot say what Equifax does, or more specifically
what their IT department does, to keep their
infrastructure up to date and secure, but I do know
that the closure of local bureaus has saved Equifax
millions of dollars in expenses over the past twenty
or so years.

But at what cost?
Implementing an online only solution to credit
reporting was a good idea at the time, but with it
came some inherent risks and costs.

Screenshot
Screenshot Showcase
Showcase

The mainstream media emphasizes purchasing and
keeping Windows up to date, (as well as making
sure the copy of Windows is registered with
Microsoft.) The fact that we are using PCLinuxOS
is proof enough of how ignorant the mainstream
media is when it comes to keeping our
information technology infrastructure working
properly.
A more famous example of what I am talking about
is what happened with a UK health care facility when
their entire network of machines became infected
with the WannaCry malware. This was a result of
indifferent management and indifferent policy when it
comes to IT maintenance.
Credit files (as well as medical records) contain
personally identifiable information that should
always be kept confidential and revealed only to
those with a legitimate need for that information.
One would think that security would be the main
priority when it comes to the IT infrastructure.
Knowing that the Windows philosophy was always
built on convenience rather than security, it is up to
the people in charge of IT to do what they can to
make the infrastructure as secure as possible, even
if it means additional costs for added security.
The articles about security in the past few months of
this magazine are examples of what we can do as
users of PCLinuxOS to make our systems as secure
as possible, and they do not cost a thing to
implement.
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Posted by luikki, September 24, 2017, running KDE.
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Security Breach At Equifax & Lessons To Learn From It
First, placing any data as sensitive as credit
information on the Internet comes with the inherent
risk of data breaches, as the technology to access
data is constantly evolving, and that no security
mechanism is perfect no matter how old that security
mechanism is.

International Community
PCLinuxOS Sites

Second, there is a cost of consumer trust and
confidence in credit bureaus. When Equifax
maintained local bureaus (the same applies to
TransUnion and Experian), people had face to face
contact with the credit bureau as there were people
staffed in the office ready to help the consumer right
there and then. Dispute cases were opened on site
and processed on site. One could put trust in the
credit bureau to help solve credit problems, because
people were there to solve these problems.

Netherlands

Turkey

Now, with the online presence, relations with the
consumer could not be more distant or faceless.
What a price to pay to save a few dollars.
When we think about it, the same could be said for
social media in general. A CNN report not too long
ago was about a generation of people who are so
addicted to social media and the smartphones used
to access that social media, they may be standing
next to one another and yet be so isolated as if they
were thousands of miles apart.
While we have the PCLinuxOS Forum to interact
with one another, it is more important that we take a
break often and actually live in the real world.
PCLinuxOS will still be there and (if funded properly)
will be there for the next generation of Linux users.
Editor’s Note: If you are worried that your data may have
been a victim of the Equifax data breach, you can securely
check to see if your data was involved here, at Equifax’s
TrustedID site. Just enter the requested data, and you will
immediately receive an answer.

Denmark
Czechoslovakia

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...

Italy

Poland

Brazil
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Google Maps Tips
by Meemaw

• Add multiple stops on your journey. Start by entering your starting point and
final destination. Then, click the three dots in the top right corner and “add stop.”

I saw this list in a newsletter that was sent to me by my local printer. It’s called
printer@work and I read it online. I’m sure they get it from a service that provides
it to printing service companies. Anyway, I thought this was a great list, so I
thought I would share it. The italics are the actual article. As much as many of us
use Google Maps, I hope you find a useful tip you didn’t know before. I know I
did! (Note: The phone images are from an Android smartphone.)

I have used this many times, especially if we are going to a certain town and want
to stop somewhere in between. On my laptop, the “Add Stop” is at the bottom of
the blue directions window. Generally Maps will show you the most direct route,
but if you don’t want to go that way, you can add on your stop in between. You
can add stops at the end and re-order them as well, simply by clicking and
holding your mouse on the one you want to move and dragging it into the position
you want.

Google Map Tips
If you’ve only used Google Maps to get directions or locate an address, you’re
missing out on many other useful features. Here are just a few examples of other
things you can do with Google Maps:
• Find available ride-sharing services (such as Uber) that are available at your
location. After entering your destination in Google Maps, swipe right on the
transportation options on the top of the screen and click the stick figure holding a
briefcase. This will prompt a pop-up screen on the bottom showing price
estimates and wait times.
You can use it to find bus stops as well (circled below). However, in the two towns
I have searched, and on my laptop and smartphone, I haven’t been able to find
the menu choice they are describing.
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On your smartphone, the circles will turn into circles with letters when you get to 3
places: you simply touch the letter in front of the place you want to move and
drag it into place.
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Google Maps Tips
• See a street view image (where available). Search for a place or drop a pin.
Click on the thumbnail image to enlarge and rotate your view.
This helps if you are going somewhere you’ve never visited before. I recently had
to visit a hospital I’ve never been to, and used the street view to see what the
building looked like so I would know it when I got there. This is my phone. If I
touch the small picture at bottom left, it will open to a photo of the place, and
show a 360 degree view.

•
Search for things nearby. For example, type in “pizza near me” to see the
closest options, or enter “pizza near XYZ” to find something near your upcoming
destination.
Wow, we use this all the time… getting to a town and
wanting to go to a certain store or restaurant, you can put
in the store or restaurant name and Maps will show you if
there are any close to your location. Harbor Freight Tools
seems to be a popular store, so we search for the closest
one in some of the towns we visit. As you can see, there
are 4 near Kansas City.
•
Edit your directions by dragging and dropping any
part of your route to go around or through specific
locations.
So, I got my route, but notice the highway construction
that I don’t want to go through (top, right). I will use a
different highway, so I just drag that part of my route to
the other highway (right).
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•
Access Google Maps offline, which is great for limited or non-existent
coverage. Go to Google Maps menu (in the upper left) and choose “Offline maps”
to get started. Remember, offline maps expire in 30 days, so you’ll need to
update them if you have it downloaded longer than a month.
Honestly, I’ve never used Offline Maps, but I’ve been in a couple of places where
I could have! On your smartphone, from the menu, choose Offline Maps.
• Remember where you parked. After parking, tap the blue dot of your location
to prompt a pop-up screen, and you can mark your parking location on the map.
I’ll have to admit, I’ve never used this, but I can see how it would be useful in a
huge parking lot (like at a sports stadium or shopping mall). It would be easy to
get turned around and not know which way your car is, especially if it’s a place
you aren’t familiar with.
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Google Maps Tips
• Share your location. Click on the Google Maps menu, and choose “Location
sharing”.
Traveling with someone and get separated? This is an
easy way to get back together. If you click on Location
sharing, you will get several ways to share: Messaging,
email, Google Drive and others. You also have to choose
the people to share it with. You can also set a time limit
for your share.

The PCLinuxOS Magazine
Special Editions!

• Easily save your home and work addresses under the
Google Maps menu, so you don’t have to type them in
every time you want to navigate around them, find local
restaurants, etc.
If you have saved it on your computer, it should sync to
your phone. I have “Home” and “Work” saved, and could
save several other locations if I wanted. You can save
places, visited places or specific maps. From the map, mark a location you want
to save. On my phone, I can swipe up from the bottom (or touch “More Info”) and
get the option to Save, Share or Download.

I don’t know about you, but I use Maps all the time. My husband has gotten used
to saying, “Pull up your map and find out where (insert store or restaurant name
here) is located and how to get there…” It also helps to find where the current
road construction is, so it can be avoided. It’s really pretty handy, especially
driving through unfamiliar places. While the ones above are familiar to me, you
might have problems finding your way around. I hope some of these tips will help
you out the next time you use Google Maps.
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SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.
When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.
Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.
Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same.
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the
English
language.
Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:
0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z
6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Possible score 224, average score 157.
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PCLinuxOS Word Find: October 2017
Forum Terms
R
B
N
T
K
E
S
R
T
P
E
G
K
Z
R
D
A
A
U
Z
H
I
V
L
V
L
N
F
I
N

O
K
D
E
L
U
D
E
M
R
L
C
K
J
Q
X
W
C
I
G
M
R
O
T
Y
X
Y
D
Y
B

B
Q
K
B
G
R
Z
V
A
V
I
A
P
S
B
H
A
A
W
D
X
J
K
R
V
D
J
E
M
A

Y
J
N
E
X
K
I
W
D
K
V
V
J
A
L
H
G
R
I
J
K
V
L
T
N
E
M
A
T
E

E
N
L
I
G
H
T
E
N
M
E
N
T
I
B
L
E
S
O
X
P
A
O
F
N
D
T
A
Q
P

T
N
D
H
R
F
T
T
Q
L
U
H
J
R
V
O
C
I
R
T
N
S
X
A
Q
M
F
M
Z
C

N
D
G
K
O
T
G
N
I
A
S
O
R
O
W
U
L
B
T
O
A
E
Z
F
N
C
D
U
E
L

Y
T
F
S
T
E
Y
F
B
U
B
W
P
G
S
H
Y
G
I
N
V
R
B
H
I
M
S
G
U
I

S
N
D
Z
R
Y
O
U
R
U
U
I
C
S
X
H
O
T
K
I
U
L
E
N
A
P
I
H
C
N

T
W
D
Y
H
R
Y
A
D
M
I
N
I
S
T
R
A
T
O
R
A
U
N
D
H
U
J
S
N
U

O
R
E
D
P
G
L
H
M
Q
M
O
U
P
S
N
P
S
U
H
Q
A
V
L
O
S
E
F
W
X

H
A
V
M
S
D
M
I
K
J
N
O
E
H
R
W
R
Q
E
Y
M
A
D
K
U
M
D
Y
G
O

S
G
E
N
E
R
A
L
Z
K
Y
F
Y
E
J
K
N
R
T
O
N
A
U
P
F
H
C
T
S
S

N
K
L
L
S
A
N
D
B
O
X
W
T
S
U
N
O
Q
N
C
J
B
E
B
S
R
Q
R
F
E

E
M
O
H
F
Z
H
V
G
E
J
N
A
V
N
M
E
N
E
W
F
R
I
E
N
D
B
I
W
T

E
S
P
J
Z
B
F
E
O
A
I
Y
T
H
E
J
F
D
X
B
V
J
V
T
T
N
S
N
D
Q

R
J
E
H
X
E
U
J
Q
E
T
Z
N
M
G
T
U
L
X
I
N
Z
L
O
Z
K
M
I
H
J

C
I
R
U
N
V
H
R
P
S
S
H
B
S
X
S
P
K
L
K
W
O
C
F
O
T
M
T
H
R

S
D
S
C
Q
G
R
M
L
D
H
E
N
Z
E
V
P
L
B
C
H
F
O
A
G
X
R
Y
F
H

Y
Y
C
C
H
A
R
D
W
A
R
E
W
R
N
Z
A
O
Z
B
M
X
Z
J
T
U
D
N
N
W

L
X
O
E
D
C
Y
H
X
J
J
P
S
J
F
I
G
T
D
B
F
G
U
P
G
L
W
E
A
C

H
F
R
T
V
S
M
K
B
E
J
S
S
G
N
R
E
T
N
E
C
E
M
O
C
L
E
W
J
E

T
P
N
I
I
I
A
S
T
S
E
U
Q
E
R
E
M
E
H
T
D
N
A
K
R
O
W
T
R
A

N
S
E
O
L
G
L
D
O
C
S
T
J
F
X
T
E
S
T
I
M
O
N
I
A
L
S
K
L
I

O
T
R
T
O
V
E
Y
T
N
Y
U
T
M
R
Y
Z
L
G
N
I
K
R
O
W
T
E
N
A
T

M
S
J
I
X
X
W
I
M
I
F
U
R
O
C
Z
V
I
E
Z
M
E
N
I
Z
A
G
A
M
K

M
C
G
F
W
R
O
O
Z
R
E
B
M
E
M
R
O
I
N
U
J
P
R
I
D
W
D
P
Z
W

V
S
C
M
S
N
C
T
I
P
S
A
N
D
T
R
I
C
K
S
G
W
X
A
Y
H
T
Z
Q
J

P
E
D
O
Q
B
L
M
W
G
H
P
A
C
K
A
G
E
R
S
J
P
N
T
Z
W
C
H
D
I

K
N
W
B
U
T
P
Z
P
C
F
U
L
L
M
E
M
B
E
R
C
D
S
N
E
K
V
D
A
C

Administrator

Advanced Users Section

Artwork and Theme Requests
Cinnamon

Developers Corner

Discussion

Enlightenment

Full Member

General

Hardware

Hero Member

International

Junior Member

KDE

LiveUSB

LXDE

Magazine

Mate

Moderator

Monthly Screenshots MyLiveCD
Networking

New Friend

Packagers

PCLinuxOS

Profile

Sandbox

Software

Super Villain

Testimonials

Tips and Tricks

Trinity

Virtual Machines

Welcome Center

XFCE
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PCLinuxOS Puzzled Partitions

Forum Terms Crossword
1.
2.
3.
4.
5.
6.
7.

Helps you with your equipment
Just joined the forum
Images of others’ desktops
Introduce yourself here.
The default desktop
Also called E21
Community-made desktop with a
mouse logo
8. The members who keep us updated
9. For the ones who know everything
10. Our favorite distro!
11. Watching to make sure you’re behaving
12. Where the fun is!
13. You’re reading it now!
14. Helping you get online
15. One of the community desktops
16. Someone who’s been here a while
17. Here’s where you post your awesome
reviews!
18. Post some knowledge to make things
easier
19. Many countries post here
20. A person who controls everything on
the forum
21. Please make my desktop look prettier!
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Cryptograms

PCLinuxOS Puzzled Partitions

From the computer of ms_meme:

Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous people. The magazine article
about secure passwords made me think of the cryptograms. We have people in the forum who are always posting famous/wise/silly sayings. I have made a few
into cryptograms, and hope our readers will enjoy them.
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More Screenshot Showcase

Posted by Mr Cranky Pants - YouCanToo, September 4, 2017, running KDE.

Posted by HERTZ, September 24, 2017, running MATE.

Posted by Meemaw, September 4, 2017, running Xfce.

Posted by bliss, September 5, 2017, running KDE.
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